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R3C-GeoResilience | Aims, Mission and Vision

Introduction

The R3C-GeoResilience is an open-source QGIS plugin designed to assess territorial vulnerability through
a comprehensive multi-risk analysis. Developed by R3C over the past years, it supports local decision
makers in building resilience in their regions. Now available for download, the tool is user-friendly and
accessible to a broad range of users.

The R3C-GeoResilience offers both a basic and advanced version, catering to different levels of expertise.
The basic version enables researchers, decision makers, and practitioners to visualise territorial
vulnerabilities from a standardised, non-weighted perspective. For more advanced users, the tool allows
for custom weighting of indicators, providing a deeper, more tailored analysis of specific territorial
challenges.

The main contribution of this tool is its ability to deliver a comprehensive assessment of the various
vulnerability components within a territorial system. This not only raises awareness of vulnerabilities but
also enhances the decision making process by equipping planners and decision makers with the
knowledge needed to design adaptive policies and land-use plans. In doing so, it helps territories prepare
for uncertainties and disruptions, fostering resilience.

This map combines ali the indicators, consid ing their correlation values
Questa mappa combina tutt! gii indicatori, tenendo conto del loro valovi ol eorrelazione



https://www.youtube.com/embed/pkjkJZiLmJk?feature=oembed
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R3C-GeoResilience | Aim

Provide a replicable and adaptable methodology for assessing and visualising the
vulnerability of a territory

e The spatial representation of vulnerability by integrating sensitivity, pressure, and shock indicators
into a comprehensive framework

e Supporting researchers, decision makers, and practitioners through a multi-risk analysis of
territorial vulnerabilities

e User-friendly access to both basic and advanced analyses, allowing customisation of weighted
indicators based on needs

e Enhanced resilience strategies by offering insights into the specific vulnerabilities of different areas

R3C-GeoResilience | Mission

Provide a GIS-based tool for assessing and visualising vulnerabilities in a way that informs
resilience-building measures
¢ The identification and quantification of vulnerabilities across different spatial scales
e The facilitation of participatory and data-driven decision making processes

e The promotion of sustainable and resilient territorial development through clear, actionable
insights for researchers, decision makers, and practitioners

R3C-GeoResilience | Vision

Establish a place-based multi-risk vulnerability assessment and territorial resilience planning
e Widespread use in various regions and contexts, empowering communities to proactively address
and mitigate systemic risks

e Continuous development and expansion of its features to incorporate new challenges, such as
evolving stressors, and emerging hazards

e Serving as a bridge between complex scientific methodologies and practical decision making,
ensuring that every area has the tools to thrive in the face of adversity



R3C-GeoResilience | Methodology

R3C-GeoResilience methodology for assessing
territorial vulnerabilities uses a place-based approach

R3C-GeoResilience methodology is at
the same time applicable to other contexts

R3C-GeoResilience proposes a tool to measure
local vulnerability using a multi-risk approach

R3C-GeoResilience methodology integrates multiple
indicators clustered into three factors defined as
sensitivities, pressures, and shocks
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Resilience is the key
to coping with the ongoing global challenges
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Measuring territorial vulnerabilities helps enhance

resilience by identifying areas of weakness, enabling
targeted interventions and informing decision making
for adaptation and mitigation strategies )

-
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R3C introduces a methodology for mapping
vulnerabilities considering environmental, social and
economic factors and from a multi-risk perspective
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The R3C-GeoResilience

open-source platform makes the
methodology applicable to other contexts
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R3C-GeoResilience | Download

1. Access our publications on the link below to understand the R3C-GeoResilience Methodology
2. Download the R3C-GeoResilience QGIS Plugin using the link below

3. Explore the R3C-GeoResilience manual

4. Input the data in the R3C-GeoResilience plugin

5. Visualize the territorial vulnerability maps interactively

DOWNLOAD | R3C-GeoResilience
DOWNLOAD | QGIS

DOWNLOAD | Publications:

e Assessing Territorial Vulnerability. Testing a multidisciplinary tool in Moncalieri, Italy

e Territorial Resilience: Toward a Proactive Meaning for Spatial Planning

e Mapping Urban Resilience for Spatial Planning—A First Attempt to Measure the Vulnerability

of the System

Asoessing territorial vulrera ity



http://www.serena.unina.it/index.php/tema/article/view/9069
http://www.serena.unina.it/index.php/tema/article/view/9069
https://www.mdpi.com/2071-1050/11/8/2286
https://www.mdpi.com/2071-1050/11/8/2331
https://www.mdpi.com/2071-1050/11/8/2331
https://forms.gle/wRkACfRQgkmX3nLH9
https://qgis.org/download/
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R3C-GeoResilience | Installing the Plugin

» Download Zip File > Access QGIS > Select window Plugins > Manage and Install Plugins >
Install from ZIP

(2 Plugins | Install from ZIP

X
e AN
I‘!!: Installed If you are provided with a zip package containing a plugin to install, please select the file below and click the Install
. . plugin button.
Mot installed Flease note for most users this function is not applicable, as the preferable way is to install plugins from a repository.
74 Upgradeable
ZIP file:
Install from
ZIP
Install Plugin
» Select the ZIP file that you download "R3C-GeoResilience" > Install Plugin
= Plugins | Install from
) Plugins | Install from ZIP x
L Al
I‘!!: Installed If you are provided with a zip package containing a plugin to install, please select the file below and click the Install
- . plugin button.
Mot installed Please note for most users this function is not applicable, as the preferable way is to install plugins from a repository.
24 Upgradeable
ZIP file: |C:\R3C-GeoResilience\R3C_GeoResilience.zip L x|
Install from
ZIP
. Install Plugin
# Settings
» The R3C-GeoResilience should appear on your Plugins tab
() Untitled Project — QGIS
Project Edit View Layer Settings QMG Vector Raster Database Mesh Help
D _ [EE @ =§ i 'rﬁ Manage and Install Plugins... 2 =
. Python Console

B@V- 8 B

Ctrl+Alt+P

R3C_GeoResilience

» | L5 R3C_GeoResilience

Browser &
AET®O
57 Favorites -

v [0 Spatial Bookmarks
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R3C-GeoResilience | Preparing QGIS Data

To apply the methodology in your area, it is necessary first to create a shapefile that includes all
the information regarding every single indicator that you aim to use in your area. These indicators
must refer to sensitivities, pressures, and shocks. A brief explanation of how to create your
shapefile is provided below in different steps:

1. Interpolation

The first step is creating raster files of each indicator through interpolation techniques. Different
QGIS tools can be used based on the nature of the data (e.g. point density, line density, etc.).

Click here for a tip on how to use this tool on QGIS > INTERPOLATION

2. Overlay of indicators
Convert all raster files to points and make a spatial joint of all point layers.

Click here for a tip on how to use this tool on QGIS > RASTER TO POINT
Click here for a tip on how to use this tool on QGIS > SPATIAL JOINT

3. Create a Fishnet grid
Use a fishnet function to create a grid of 200m x 200m.

Click here for a tip on how to use this tool on QGIS > FISHNET

4. Point to Fishnet

Insert the value of the point layer, which includes all indicators, into the layer Fishnet using spatial
joint between the two layers.


https://docs.qgis.org/3.34/en/docs/gentle_gis_introduction/spatial_analysis_interpolation.html
https://gis.stackexchange.com/questions/77306/how-to-convert-raster-to-point-in-qgis
https://www.qgistutorials.com/en/docs/3/performing_spatial_joins.html
https://gis.stackexchange.com/questions/123444/creating-fishnet-grid-shapefile-in-qgis
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All the indicators must be normalised, so the attribute table of the Fishnet will be exported to
Excel, normalised, inserted again in QGIS and joined to the grid.

The normalisation formula is:

X; o X Xmi-n
X!HH.I.’ X’HN‘H
e X' normalized value

e X: original value

*  X,,in: minimum value in the dataset

e X,,qz maximum value in the dataset

You should have two shapefiles to be inserted on the R3C-GeoResilience Plugin:

1. Shapefile containing all the layers of indicators
2. Shapefile border of the area you are analysing
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R3C-GeoResilience | Preparing Excel Matrix

To apply the methodology in your area, it is necessary to create an Excel matrix that includes all
the information regarding every single indicator that you aim to use in your area. These indicators
must refer to sensitivities, pressures, and shocks. The R3C-GeoResilience framework allows for a
maximum of nine indicators across these categories. A brief explanation of how to create your
Matrix Excel is provided below in different steps:

1. Filling in the Excel Matrix

[ Sensitivity I Pressure I Shock }

Component_A Alias_A Component_B Alias_B Component_C Alias_C Pressure Alias_P Shocks Alias_S

Al IMP B1 RIA C1 PD P1 SC 51 FL

A2 TREES B2 CHS c2 EC P2 DE 52 SR

A3 GREEN B3 BA c3 IC P3 53 LS

A4 B4 CLA ca SAS P4 54 UHI

A5 B5 ESA c5 P5 S5

A6 B6 cée P6 56

A7 B7 c7 P7 57

A8 B8 c8 P8 S8

A9 B9 c9 P9 59

The columns in the SHP in the QGIS file must be named with the names shown in grey, which
cannot be changed (so A1, C1, P1, S1...)

To indicate that there is no value: leave the Alias blank
To indicate the data: provide a value to the corresponding Alias
“» Important: Please do not modify the Excel file; simply fill it in with your data. There must

be a correspondence between the contents of this Table, the Correlation Matrix and the
input data grid on the SHP in QGIS, otherwise, the Plugin will identify irregularities

10



2. Create another file including abbreviation and description of indicators
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Al IMP. Impermeability impermeable area/total area of the grid

A2 TREES Availability of planted frees number of total planted trees / total area of the grid

A3 GREEN Availability of Green spaces public green spaces area / total area of the grid

B1 RIA Road infrastructure availability (total lengths of road infrastructure * road class) / total area of the gird

B2 CHS Cultural heritage sites number of culfural sites / fotal area of the grid

B3 BA building number of / total number of

B4 CLA Cycling lanes availability total length of cycling lines / total area of the grid

B5 ESA ducational services availability number of schools / inhabitant

c1 PD P ion density in each census section / area of the census section

c2 EC Elderly P T pop in each census section aged > 65 years / tofal pop of the census section
c3 [ Immigrant immigrants in each census section / total of the census section
c4 SAS Social assist: servises number of social assist: centres in each zone/ total are of the zone

P1 SC Soil soil / fotal area of the grid

P2 DE pop total pop 2007 - total pop 2023 / area of the grid

51 FL Floods places with risk of occurrence of floods / area of the grid

52 SR Surface run-off places with risk of Surface run-off according to the past record / total area of the grid
S3 LS Lands slides places at risk of hillside / total area of the grid

54 UHI Urban Heat Island (UHI) level of exposure to the risk of UHI /total area of the grid

3. Choose the weighting of indicators that is better for your analysis:

To have a general analysis of the area

All indicators weight at 1

Option 1: "Basic"

Option 2: "Advanced"

All indicators with a specific weight

To have a technical analysis of the area

*“** Option 1: All weight at 1

3308388 RPBRS R REBRREERERRERE

P1
1.00

1.00

1.00
1.00
1.00
1.00
1.00

1.00
1.00
1.00
1.00

P2
1.00

1.00

1.00
1.00
1.00
1.00
1.00

1.00
1.00
1.00
1.00

P3

P4 P5 P6 P7

P9 51 52 53 sS4 S5 56 57 58 59

1.00 1.00 1.00 1.00

1.00 1.00 1.00 1.00

1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00

1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00
1.00 1.00 1.00 1.00
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Option 2: weight

1. Fill the Matrix (Excel file) with Sensitivity, Pressure, and Shock Indicators
e Prepare a matrix where each row represents a Sensitivity indicator, and each column represents
a Pressure or Shock indicator.
e This matrix will be used to analyse how Sensitivity indicators relate to both Pressures and
Shocks.
2. Use a Participatory Methodology
e Involve a team of experts to participate in filling out the matrix.
e Each expert independently evaluates the relationship between the sensitivity and
pressure/shock indicators.
3. Rate the Relationships Using a Likert Scale
e For each cell in the matrix (where a sensitivity indicator intersects with a pressure or shock
indicator), the researchers will assess the relationship's intensity based on the following ordinal
Likert scale:
o 0: No relationship
o 1: Weak relationship
o 2:Strong relationship
o 3:Very close relationship
4. Calculate the Average Score for Each Indicator Pair
e After collecting all the experts' ratings, compute each matrix cell's average score.
e This average score reflects the consensus on the strength of the relationship between a
sensitivity indicator and a pressure or shock indicator.
5. Normalize the Results
e Once the averages are calculated, normalise these values. Normalisation ensures that the values
are on a standardised scale, typically between 0 and 1.
e A normalised value of 0 indicates no relationship, while a value closer to 1 indicates a stronger
relationship.
6. Visualize the Matrix
e The normalised values are presented interactively on the matrix.
e Each cell in the matrix is coloured based on the strength of the relationship, using a semaphore-
style colouring system:
o Green: Low relationship (values closer to 0)
o Yellow: Medium relationship
o Red: High relationship (values closer to 1)
7. Prioritize Based on Relationship Strength
e The coloured matrix allows for easy visual prioritisation of relationships. Indicators with stronger
relationships are given higher priority, i.e., those in red cells.
8. Your Matrix is ready to be used on the plugin

12
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Rate:0to 3

P1 P2 P3 P4 P5 P& p7 P8 P9 S5 s6 s7 s8 59
Al
A2 2.00
A3 2.00
Ad
A5
A6
A7
AB
A9
Bl 2.00  2.00
B2 1.00  1.00
B3 1.00
B4 1.00  2.00
5| o.o0EEE 1.00 1.00 100 1.00
B6
B7
B8
B9
e m e
2.00 200 200 2.00
ISEORSOOS  2.00
Normalise:0to 1
P3 P4 3 P6 P7 P8 P9 $5 s6 s7 s8 $9
A2
A3
A
AS
A6
A7
AB
A9
B1L | 067" 067 " 067" 067" 0677 0323
B2 | 033" 032 " 033" o067
83 [ o[ EEE " 033" 033 " 033
B4 | 0337 067 " 033" 033" o033
BS 033" 023" 033" o033
B6
B7
B8
B9

067" 067 067

13
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R3C DASHBOARD | Visualise Results

The R3C-GeoResilience consists of 3 fundamental files:

1. The GRID shapefile (.shp) including all the layers
2. The boundary file (.shp) of the area

3. The Matrix data Excel file (.xIsx) Excel file, including the indicators and their weight

1. Insert data

Add all the files and press Start

| (Y Dashboard_R3C X

R3C_GeoResilience

Input View data Calculation
Grid file (.shp) :/R3C-GeoResilience/02_Torino/01_GRID/GRID_T0O.shp| |...|
Boundaries file (.shp) :/R3C-GeoResilience/02_Torino/02_confini/lim_line.shp
Matrix data (.xlsx) C:/R3C-GeoResilience/02_Torino/03_Excel/ TORIND.xlsx
EPSG code EPSG:32632

Start

R3C

‘ Responsinle | R@View input data... Exit
Risk

Rasiliance
Centre

AN e
Politecnico
Mﬁ di Torino
e

e
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2. Visualise the vulnerability map of a single indicator

On this tab, you can visualise the vulnerability map of single indicators. In addition, it also allows for the
interaction of classification methods, colours, invert, classes and transparency.

@ Dashboard_R3C X
R3C_GeoResilience

Input Wiew data ‘ Calculation

Component A Component B Component C Pressures Shocks
e A1 S Oa et (st
) a2 (e O e m (s
() Az (e Oa (e () s3
() aa " O o () pa () sa
() oas e O es oes (s
) es ) cs oee () s6
() a7 () er O e (er () s7
() e [ es O oca [ es () se
() a9 es e oes (s
Classification Method Color ramp Invert Classes Transparency
| QgsClassificationEquallnterval() b | | Spactral hd 10 hd |:I

AN R3C S
Y Politecnico "
{H .;; di Tol'il'lo :?‘:Eo.nsublo Ex]t
e R sllence AL -
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In the third tab, click "Run Calculation" to view the overall vulnerability map of the area. This map
combines all the individual indicators from the previous tab and considers the correlation value of the
indicators (if inserted in the last sheet of the Excel file).

Additionally, for each sensitivity component, there is a bar where you can assign a weight from 0 to 1
based on your preference. For example, if you want to visualise only the vulnerability of your area due to
environmental sensitivities (component A), you should set the value to 1 for the first two bars and 0 for
the rest. Another example is if you want to visualise the vulnerability only to shocks. In this case, set the
second, fourth, and sixth bars (referring to shocks) to 1 and the rest to 0.

LC

R3C GeoResilience

Input View data Calculation

Weight attribution to Pressures and Shocks

A/ Pressure 1.0 Run calculation

A/Shocks 1.0

B/Pressure 1.0

B/Shocks 1.0

C/Pressure 1.0

C/Shocks 1.0
Classification Method Color ramp Invert Classes Transparency
Qg=ClassificationEquallnterval{) v Spectral - 10 b

% %
{ J Politecnico

T -m- di Torino
L)

ho 1."‘"'”

&
e | Exit
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R3C DASHBOARD | Key Concepts

* RESILIENCE

The capacity of social, economic and environmental systems to cope with a hazardous event or trend or
disturbance, responding or reorganising in ways that maintain their essential function, identity and
structure, while also maintaining the capacity for adaptation, learning and transformation (IPCC, 2014).

“* VULNERABILITY

Vulnerability if the propensity or predisposition to be adversely affected. It encompasses a variety of
concepts and elements including sensitivity (IPCC, 2022). The methodology of R3C considers vulnerability
as a function of sensitivities, hazards and pressures.

% SENSITIVITY

The degree to which a system or species is affected, either adversely or beneficially, by climate variability
or change. The effect may be direct (e.g., a change in crop yield in response to a change in the mean,
range, or variability of temperature) or indirect (e.g., damages caused by an increase in the frequency of
coastal flooding due to sea level rise) (IPCC, 2014).

“* HAZARD

The potential occurrence of a natural or human-induced physical event or trend that may cause loss of
life, injury, or other health impacts, as well as damage and loss to property, infrastructure, livelihoods,
service provision, ecosystems and environmental resources (IPCC, 2014). According to R3C methodology,
Hazard can be due to either chronic stress or an acute shock.

“ ACUTE SHOCK

A sudden, intense, and often unexpected event that has immediate and significant consequences for
human societies, ecosystems, or the environment (100 Resilient Cities, 2019). Shocks are unpredictable
and dangerous events that threaten the system occasionally with a high impact on the environment,
settlements, and populations (IPCC, 2021). They are intended as catastrophic events that the system
should absorb in adverse conditions. Since the occurrence of shocks is viewed over a long time, their
effects are often unpredictable.

“* PRESSURE

Pressures are linear and predictable trends that affect the system, gradually altering its condition (IPCC,
2012). The pressures affecting the components of the system progressively increase their sensitivity,
making them more vulnerable to more significant events represented by Hazards. In addition, they follow
specific temporal behaviours, in some cases described by literature (i.e., soil consumption and population
ageing), in other cases more difficult to understand (i.e., obsolescence of buildings). Moreover, pressures
enable the construction of future vulnerability scenarios at a given time. Pressures are driven by chronic
stressors, which are the persistent, long-term impacts on societies, ecosystems, and the environment over
an extended period (100 Resilient Cities, 2019).
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